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Preface

This eBook introduces you to a series of lab sheet to develop a 2D
game (Space Shooter). It mainly focuses on the steps by steps
guidance on how to develop a 2D game using Unity software.

2D CAME DEVELOPMENT introduces the techniques to develop
computer games by using game development tool. The readers will
be able to understand the concepts of sprites and object, game
interactivity, level design and scripting in the development of game
of different genres.

Since this eBook provides an outlook of the overall guidance to
develop 2D game, after going through this material, you will find
yourself at a moderate level. It will heaps your knowledge from basics
to the next levels
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Now : LABSHEET 1 : Introduction to 2D Game Assets Next : LABSHEET 2 - Organizing Unity Files and Project

A) Installation 2D Game Development software
1. Installing Unity Hub
a. The Unity Hub is a management tool that you can use to manage all of
your Unity Projects and installations, To install the Unity Hub for
Windows, MacOS, and Linux visit :

https://unity3d.com/qet-unity/download
b. Choose UNITY HUB to begin download installation file

@ unity Products Solutions  Case Studies Learmning  Support & Services

Download Unity

Welcome! You're here because you want to download Unity, the world’s most popular development platfort
2D and 3D multiplatform games and interactive experiences

Before you download choose the version of Unity that's right for you/

Learn more about the new Unity Hub here.

c. Download file and select the file to begin installation

Download Unity Beta

Get early access to our latest features, and help us improve quality by p

By clicking “Accept All Cookies)
assist in our marketing effog€.

a UnityHubSetup (1).exe ~

d. Complete installation and run UNITYHUB

4 Unity Hub 245 - o x

ou agree to the storing of cookies on your device to enhance site na

Qunity o a6
@ Projects Projects ADD “
®  Learn

Project Name Unity Version Target Platform Last Modified 4+ Q)

&% Community

= Installs


https://unity3d.com/get-unity/download
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Now : LABSHEET 1 : Introduction to 2D Game Assets Next : LABSHEET 2 - Organizing Unity Files and Project

e. Create new UNITY Account by click on icon below :

-

Target Platform Last Modified O\

f. Login using your GMAIL account to create new user account

| ® Unity Hub Sign In % & Ediing

o '
q <Q unity

T 6

Sign into your Unity ID o m
f you d inity 1D, v I

n't have a lease create one.

b
Email
Last Modified 4 Q
e
4 days ago
Pa:
4 days ago
d
8 days ago
o 20 days ago
] © Mobile project2
d. D:\Kerja Office\FRP Short Sem 2021\Proje...  2020.3.12f1 Current platform 21 days ago
Unity Version: 2020.3.12f1
[5 proecs - ||

g. Complete sing-in step to complete UNITY account registration

@ Unity Hub Sign In X
IO SIC -

One account. All of Google.

Sign in with your Google Account

[Email or phone ‘

Find my account

Create account

h. Your Avatar at top right connect will show your name:

Styles L} Editin
4 Unity Hub 2.4.5 - ) X

& unity — 4

m Paragraph
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Now : LABSHEET 1 : Introduction to 2D Game Assets Next : LABSHEET 2 - Organizing Unity Files and Project

2. Installing UNITY ENGINE
a. Run UNITY HUB and select INSTALL; then Select ADD button to add
installation for new UNITY ENGINE VERSION

" @ Unity Hub 245 - u] X

g ——
9 Projects Installs LOCATE “

Learn

2% Communit Q Q

2020.3.12f1 s ® 2019.4.12f1 s ©

[

Installs

b. Select 2020.3.22f1(LTS) and Select NEXT button

Add Unity Version X

o Select a version of Unity

Can't find the version you're looking for? Visit our download archive for access to long-term
support and patch releases, or join our Open Beta program releases.

Recommended Release

@ Unity 2020.3.171 (LTS) ? ®

Official Releases

(O unity 2021.1.19f1 @
(O unity 2019.4.30f1 (LTS)

(O Unity 2018.4.36f1 (LTS) i
Pre-Releases

CANCEL BACK NEXT

c. Select Microsoft Visual Studio Community 2019 and Windows Build
Support; then select NEXT button to proceed installation process.
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Add Unity Version

Microsoft Visual Studio Community 2019

Platforms

> [] Android Build Support 373.5MB 1.96B
D i0S Build Support 364.7 MB 1.6 GB
I:’ tvOS Build Support 361.5 MB 1.6 GB
D Linux Build Support (IL2CPP) 103.5 MB 435.8 MB
I:’ Linux Build Support (Mono) 102.7 MB 428.1 MB
D Mac Build Support (Mono) 321.2MB 1.8 GB
I:’ Universal Windows Platform Build Support 289.1 MB 2.1GB
D WebGL Build Support 319.5 MB 1.2GB
2 windows Build Support (IL2CPP) % 82.0 MB 432.7 MB

CANCEL BACK NEXT

d. Agree condition and select DONE button

End User License Agreement X

Visual Studio 2019 Community License Terms

Please review and accept the license terms before downloading and installing Microsoft Visual Studio.

https://go.microsoft.com/fwlink/?linkid=2092534

. [ read and agree with the above terms and conditions

CANCEL ONE

e. Wait until installation complete
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Now : LABSHEET 1 : Introduction to 2D Game Assets Next : LABSHEET 2 - Organizing Unity Files and Project

B) GAME ENGINE’S INTERFACE

| O 5

(A) The Toolbar : provides access to the most essential working features. On the left
it contains the basic tools for manipulating the Scene view and the GameObjects
within it. In the centre are the play, pause and step controls. The buttons to the
right give you access to Unity Collaborate, Unity Cloud Services and your Unity
Account, followed by a layer visibility menu, and finally the Editor layout menu
(which provides some alternate layouts for the Editor windows, and allows you to
save your own custom layouts).

(B) The Hierarchy window : is a hierarchical text representation of every
GameObiject in the Scene. Each item in the Scene has an entry in the hierarchy, so
the two windows are inherently linked. The hierarchy reveals the structure of how
GameObjects attach to each another.

(C) The Game view : simulates what your final rendered game will look like through
your Scene Cameras . When you click the Play button, the simulation begins.

(D) The Scene view : allows you to visually navigate and edit your Scene. The Scene
view can show a 3D or 2D perspective, depending on the type of Project you are
working on.

(E) The Inspector Window : allows you to view and edit all the properties of the
currently selected GameObject. Because different types of GameObjects have
different sets of properties, the layout and contents of the Inspector

window change each time you select a different GameObject.

(F) The Project window : displays your library of Assets that are available to use in
your Project. When you import Assets into your Project, they appear here.

(G) The status bar : provides notifications about various Unity processes, and quick
access to related tools and settings.
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Now : LABSHEET 1 : Introduction to 2D Game Assets Next : LABSHEET 2 - Organizing Unity Files and Project

C) RESOURCES IN GAME DEVELOPMENT
1. Creating New Unity Project File
a. Login to your CIDOS/ Google classroom portal account, and download
“labsheetl_resource.unitypackage” from download section.
b. Open UNITY HUB to create new project; select NEW button at the top
right corner of UNITY HUB window

Last Modified > O\

Unity Version
2020.3.12f1 Current platform 12 hours ago
2020.3.12f1 Current platform 17 hours ago

c. Next, choose 2D from template, then name or project as “labsheet1”
and locate your project file into New Folder called “Labsheet”.

@ Create a new project with Unity 2019.4.12f1

Labsheet_1 V

D}na Office\FRP Dis 20271 DFG40143\Lab...

“
il

d. Select CREATE button to create the project
2. Importing unitypackage file into project
a. Select and double click (2X) at “labsheetl_resources.unitypackage”
to perform installation new unitypackage file.
b. Select IMPORT button to begin installation

v | Trex.controller (e ]
~  Trex_Baked_Animations.overrideController "
< (Hwalk.anim

~ (©)Walk_Baked.anim

[N

(o]
« [jungle_0.png {Hew ]
v [#jungle_1.png i |
v [#jungle_2.png wm

o Eliunala 3 ann
All None Cancel | Import
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3. Opening Game Scene
a. Select “Scene” folder in Project Panel inside “Assets” folder

[
s Project
+ v

v . Favorites |
O, All Materials ]
O, All Models
O, All Prefabs
v BAssetséﬁ z
» e Anima2D
s Animation
B Gizmos
» Bm Graphic 5
I Pose
Im Prefab

I Script
b. Select and Double Click (2X) on scene file called “level 1” inside Scene
folder

Assets > Scenes

HCQLQ

Coin sfx Lex. ell Level2 LevelSelect...  SampleSc...

r

c. Your Scene Panel will show as below :

# Scene e y
/| Shaded [ (R ‘ Gizmos | ¥




DFG40323 - 2D GAME DEVELOPMENT
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D) GAME RESOLUTION SETTING
1. Open previous game project (C.1)
2. Select Game View

andalone - Un

Display 1 ~ Standalone (

Levell
) Main Camera

14 Player >
T) batu

7 bg_Artboard 2

7 EventSystem

1) door

7 COIN

) Script Main Menu

3. From DISPLAY 1 select STANDALONE (1024X768)

| #  o® Game
Display 1 + Standalone (1024x768) v‘ Scale -@
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Now : LABSHEET 1 : Introduction to 2D Game Assets Next : LABSHEET 2 - Organizing Unity Files and Project

4. Select ( +) button to add new Resolution
5
# Scene | o®Game | = Animator
Display 1 ~ Standalone (1024x768) v| Scale -@——

v Low Resolution Aspect Ratios
VSync (Game view only)

Free Aspect
5:4)

+ Standal (1024 x768)

Add New Item

5. Insert New value as below :

a. LABEL = Full HD

b. Width & Height = 1920 ; 1080
lisplay 1 = |Standa|one (1024x768) v| Scale @———

v Low Resolution Aspect Ratios

VSync (Game view only)

Free Aspect
5:4
4:3
3:2
16:10

16:9

Standalone (1024x768)

960x640
Add

Label |Full Hd ]
Type Fixed Resolution ~

Width & Height 1920

Full Hd (1920x1080)
OK

Cancel

6. Select OK button
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Fill the blank with CORRECT image from unity project (labsheet_1) : (use snapping tool)

1. GAMEOBJECT is the most important concept in the Unity Editor. Every object in your
game is a GameObject, from characters and collectible items to lights, cameras and
special effects.

2. SCENE are where you work with content in Unity. They are assets that contain all or
part of a game or application.




3. Audio can be it background music or sound effects. It can import most standard audio
file formats and has sophisticated features for playing sounds in 3D space, optionally
with effects like echo and filtering applied.

4. Font used to display the text. Text can be used to provide captions or labels for other
GUI controls or to display instructions or other text.




5. Script is an essential ingredient in all applications you make in Unity. Most applications
need scripts to respond to input from the player and to arrange for events in the
gameplay to happen when they should. Beyond that, scripts can be used to create
graphical effects, control the physical behaviour of objects or even implement a custom
Al system for characters in the game.




2D GAME DEVELOPMENT (LABSHEET)

Topic 2.0 : 2D Assets
Creation, Import and
Arrangement
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Now : LABSHEET 2 : Present animation with 2D Next : LABSHEET 3 — Level Design
assets for realistic gameplay

A) Setup new game project
1. Setting up game development environment
a. Open UNITY HUB to create new project.
b. Next, choose 2D from template, then name or project as “Labsheet2-
game2D” and locate your project file into New Folder called “Labsheet”.
c. Wait until your project are complete to be created.
d. Below is default interface of Unity new Project

e. Login into your CIDOS/ google classroom account and download
“Labsheet2_Part2_Resources.unitypackage”
Double click on the downloaded file to install into your project.
g. Click “Import” button

Import Unity Package -

Cancel Import

h. Asresult, a folder called Graphics will exist into your Assets folder.
i. Access to GAME VIEW tab, and make sure your Display1 setting is set to
FULL HD (1920x1080

omponent  Window  Help

% || Epivet | @clobal | 5
-

. # Scene  o»Game | = Animator
Display 1 '|FuIIHD{192{)x108{)} -
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2. Creating your first game scene
a. Firstly, we need to add background into your game scene.
b. Dragthe BG_SPACE image from the GRAPHICS folder to the hierarchy tab.

= Hierarchy 21 @ scene omGame - Animator
+- Shaded LN

v < SampleScene
) Main Camera

= Hierarchy g i | # 5
+v (oA Shade
v €] SampleScene* H
71 Main Camera
£ BG_SPACE

a Assets h
= Grapnics. bt aemy e
= Scenes.

W Package:

c. Now, drag the SPACE_SHIP to the hierarchy tab (Refer step b)
d. Your result will show as below

e. Select the SPACE_SHIP in the hierarchy tab. You can see that the inspector
tab is now full of interesting information about the SPACE_SHIP.

© Inspector =
@ v space_ship Static v
" Tag Untagged ~  Layer Default
v A Transform @ st
Paosition X0 Yo Zo
Rotation X0 Y0 Z0
Scale x1 ol 1 il
v [g v sprite Renderer T
Spiite [slspace_ship ®
Color P
Flip Al
Draw Mode: Simple
Mask Interaction None
Sprite Sort Paint Center
Material @ Sprites-Default @
¥ Additional Settings
Sorting Layer Default
Qrder in Layer 0
Sprites-Default :R-3
> Shader Sprites/Default
Add Component

f.  From Inspector Panel, change the value for SPACE_SHIP information as
below:
Position : X=0;Y=-4,7=0
Rotation : X=0;Y=0;Z=0
Scale : X=0.3;Y=0.3;Z=0.3
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Now : LABSHEET 2 : Present animation with 2D Next : LABSHEET 3 — Level Design
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g. The result will show as below

h. If you SPACE_SHIP is hidden (not appear on the screen after drag and
drop), click SPACE_SHIP at Hierarchy tab. On the Inspector tab, order in
layer change from 0 to 1.

space_ship
y Tag Untagged ¥ Layer Default

Transform

None

Center

& Sprites-Default

[PEEIH

3. Adding movement script
a. Select the ship, and in the inspector click Add Component = New script

Sprites-Default (-9

Shader Sprites/Default

Add Companent
Search
&5 Rigidbody
&5 Rigidbody 2D
“k Event Trigger

New script

b. Set the name to “spaceshipScript” = Create and Add

Add Component

rig

< New script
Name

sgacesh\gS:ngj

Create and Add
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c. Find the “spaceshipScript” in the project tab and place it inside the Scripts
folder (right click inside Assets area Create > Folder > rename to Scripts).
Then double click on the script.

M Project | & Console

+-
v - Favorites Assets
C, All Materials
O, All Models
O, All Prefabs
e 0 IR #
I Graphics
Bm Scenes
» I Packages Graphics Scenes

1. Make sure you already install MICROSOFT VISUAL STUDIO COMMUNITY 2019 into
your machine (Refer LABSHEET 1: Introduction to 2D Game Assets; Step A.2.c)

2. Make sure you already register and login into MICROSOFT ACCOUNT

d. Replace the default code by this (refer line 19) > Ctrl + S to save to script >
close script window by click

+ X

0}

transform.Translate(Input.GetAxis("Horizontal™) * * Time.deltaTime, Of, of);

e. Play your Scene by hit Play Button

» »l

i| ®ns
A | W ¥|Gizmos | v | |o @

Pos
Roti
Sca
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4. Adding gameplay element (Obstacle)
a. First let's start by creating some obstacles.
b. Dragthe “ROCK” from the GRAPHICS folder into the hierarchy tab

= Hierarchy BEN| # Scene
L 8 Shaded

v € SampleScene :
) Main Camera
(p) BG_SPACE
7 space_ship

= Hierarchy
+ - (o n
v €] SampleScene*
Ff Main Camera
) BG_SPACE
) space_ship

s Project
+

v - Favorites | Assets!
O, All Materiale
O, All Models
O, All Prefabs

¥ [ Assets
B Graphics
B Scenes
» Bm Packages

e i

c. Next, add a script component to the ROCK called "rockScript". (Refer step
A.3.a)

d. Add “rockScript” with this line by double-click to modify the script (Refer
step A.3.b)

rockScript.cs 4 X
Miscellaneous Files

: MonoBehaviour

rb.angularVelocity = Random.Range(

Update()

rb.velocity

e. Modify your script as below.
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Now : Practical Task 1

DEPARTMENT OF INFORMATION TECHNOLOGY AND COMMUNICATION

Practical Task (s)No:_1/2/3/4

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

Instruction: Manipulating Unity Assets to build your first game scene interface
1. Crete new scene inside Scene Folder in Assets by opening Scene Folder inside Assets Folder

B Lebsheet 2- SarmpleScene - PC, Mac & Linux Standilone - Unity 20194.12f1 Personal <DX11>
File Edit Assets GameObject Component Window Help

= Folder | |

Show in Explorer

=] C# Script animat
- Shadler > s
M et Testing >
Playables >
Copy Path Al CtrieC g .
Assembly Definition Reference
M Project | B Console TectMeshPro >
i |mport New Asset..
¥ - Favorites Assets > Scenes Import Package >
O, All Materials Export Package. Audio Micer
O, All Models #
Q. All Prefabs Q Select Dependencies [iit::‘:‘m
v = Assets Refresh Cri+R Render Texture
Bm Graphics SampilaSe. Lightmap Pararneters
Bm Scenes Reimport All Custom Render Texture.
E=lEsctagas Sprite Atlas

Extract From Prefab
Sprite Library Asset (Experimental)

Sprites >

2. Then access menu bar to create new scene ( Menu bar = Assets - Create = Scene )

3. Name your Scene as “Main_Menu”
B Project | E Console

Favorites Assets > Scenes
<, All Materials

O, All Models
O, All Prefabs Q Q
[ Assets

B Graphics SampleSc...

Im Scenes
s Packages

Bm Aceate/Sranae

4. Create a canvas in the hierarchy pane ( + button 2UI = Canvas) .

= Hierarchy h =0
+ - =

Create Empty
Create Empty Child
3D Object

2D Object

Effects

Light

Audic

Video

_ Text
Camers Text - TextMeshPro

Image

B )

Raw Image

Button

Button - TextMeshPro

Toggle

Slider

Scrollbar

Dropdown

Dropdown - TextMeshPro

Input Field

Input Field - TextMeshPro B

M Project | E Console | |
i -_
- Panel -

¥ = Favorites
C, All Materials Scroll View

C, All Models Event System
CL All Prefabs e
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(Right click at canvas =» Ul =» Image) Ren
BG.

= Hierarchy |
+v

8| #scene |8

a
v € SampleScene*
1 Main Camera

@ Event
Past
Rename
Duplicate
Delete

Create Empty
3D Object
2D Object
Effects

Light

Audio

Video

Camera ' Text - TextMeshPro

Raw Image

Change the image by dragging and drop

6.

Source Image at inspector panel as shown below

T
FCJl_iTEII-(niI-(
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Next : Practical Exercise 1

Under the canvas create an image to insert background image.

ame the image as

"= Hierarchy
+ v [
v €} SampleScene*

£F) Main Camera
v () Canvas

[ EventSystem

ping “background” inside Graphics folder into

1w

v < SampleScene*
[0 Main Camera
v (7] Canvas

() EventSystem

M Project | B Console
+ a

17

@ v BG  staticr
T Tag Untagged  ~  Layer Ul v
v it Rect Transform @ i
center PosX  PosY  PosZ
3 0 0 0
2 Width  Height
100 100
» Anchors
Pivot X05 |Yo05
Ratation X0 Y0 zZ0
Scale x1 ¥ Z1
v @  canvas Renderer @
Cull Transparent Mes
v Bl v Image 3
Source Image None (Sprite) ©
rd
None (Material) [}
v
Maskable v
Default Ul Material e

v - Favorites Assets > Graphics

©, All Materials
C, All Mode!:
C,All Prefa nss r_=1b r.1>
L) y
v 2 sss A a4
= Graphics backgroun..  exit_button  menu_butt.  play_button
B Scenes
» I Packages
&
setting bu..

File Edit Assets GameObject Compenent Window Help
W | O @ Global | 15

= Hierarchy |

+ -

v <0 SampleScene*
) Main Camera

| vfcawas

»  Shader UlDefault

Add Component

Double Click at Canvas from Hierarchy Panel to show your screen
Resize your BACKGROUND to fix the whole canvas using RECT TOOL
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MALAYS|A Next : Practical Exercise 1
MET:0 EUALA LUMPUR

Then create a button under the canvas. (Right click at canvas =» Ul =» Button). Rename it as
Play.

= Hierarchy
4+ (oAl
v & SampleScene®

) Main Camera

B s
() EventSyste Paste

Rename

Duplicate
Delete

Select Children

"= Hierarchy
+- (oAl
v €] SampleScene*
() Main Camera
¥ ) Canvas

Select Prefab Root

Create Empty
3D Object
2D Object
Effects

Light

Audio

Video

d Camera ‘ ‘Tat - TextMeshPro

Assets > Graphics Image

M Project
+-

¥ - Favorites

©, All Materials Raw Image
L Al Models
©, All Prefabs L e
Bk Button - TextMeshiro
v @ Assets Togql
B Graphics backgroun..  ext {223

10. Drop down at PLAY button and delete Text item.

v [ Canvas

) EventSystem

Duplicate

Select Children

11. Select PLAY button inside Hierarchy panel, and drag the Green Play button from Graphic

Folder into Source Image at Inspector Panel.

R
(EXJED v RectTransform o

DPLAY

PosX  PosY  Posz
D Eventsystem [ .
{18 o on
60 |30 AR
» Anchors
Piot  X05 V05

Rotaton X0 Y0 20
scale X1 v1 iz

e ©
z
None (Vateria) ©
orites
I Materials FillCenter
iIModels Pixels Per Unit Mul 1
i1Prefabs v ® - Button o= :
ets Interactable a
APt =T Transition ColorTint
== TargetGraphic  EPLAY (mage) ©
Kages
72\ Nl 7l

12. Tick PRESERVE ASPECT at Inspector Panel as below and resize your button using RECT TOOL

at menu bar:

v El 7 Image @ ;
Source Image Eslplay_button 2
Color Z
Material None (Material)

Raycast Target v

Maskable |

Image Type Simple -
Use Sprite Mesh [ |
iy e @ h

Set Native Size

v @ v Button @
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13. Duplicate PLAY button at Hierarchy panel by (Right Click -> Duplicate) ; rename as SETTING

14

15
16

17

18.
19.
20.

21.
22.
23.

and QUIT
‘= Hierarchy # Seene .
+-
¥ € SampleScene* : + = (oAl

= Hierarchy

{1 Main Camera ¥ < SampleScene*
v g;;as £ Main Camera
v [l Canvas
(DEven  Copy @ BG
Paste @ PLAY
) SETTING

Rename

Delete

. Arrange your buttons as shown below

. Next, change Image Source for SETTING and EXIT button by repeating step at 10
. Result as shown below :

. Now go to Cooltext Graphics Generator (https://cooltext.com/) and generate the wording of
MY GAME using different graphics. Your also can design using Adobe Photoshop or Adone
[llustrator.

Import or Paste the graphic into the asset folder. (Refer step Labsheet 2 > A.1.e)

Create new Image into your Hierarchy Panel ( Refer step 4 ), name as LOGO.

Change the image by dragging and dropping “Title Graphic” from Step 16 into Source Image at
inspector panel ( Refer step 5)

Arrange your design as your own style.

Submit your Practical Task 1 at CIDOS.

PASTE your OUTPUT below



https://cooltext.com/

T
PDLiTEI;\(HiI—(

: i MALAYS Next : Practical Exercise 1
Now : Practical Task 1 AALAYS | A

Name: Registration Num.:
Code & Course: DFG40143 - 2D GAME DEVELOPMENT Programme/Class:
Practical Task (s)No:_1/2/3/4 MARKS: /20

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

1. PASTE your OUTPUT below :

MOHD FAKHRURRAZI BIN KHODARI
Pensyarah
Jabatan Teknologi Maklumat dan Komunikasi
Politeknik METrO Kuala Lumpur


rhaze
razi


DFG40323 - 2D GAME DEVELOPMENT
EXERCISE 2

Code & Course: DFG40143 2D GAME DEVELOPMENT

1) Write down the path of your saved Labsheet2 project below:

2) How many folders exist in Assets Folder and list down all of them?

Scene and Graphics

Assets » Graphics » Labsheet_2_Resources

axit_button menu_buttan play_button satting_butt...




DFG40323 — 2D GAME DEVELOPMENT
EXERCISE 2B

Code & Course: DFG40143 2D GAME DEVELOPMENT

1) Whatis the function of Position in Inspector panel? (Refer step A.2.e)

2) Change the script at A.3.d to slow down the movement of the ship. Write down
your script below:

3) Add this script into your script (AT LINE #20) and describe the result:

transform.Translate(Input.GetAxis("Vertical™) * Vector3.up * 15f * Time.deltaTime);

4)  What is the final result of this labsheet?



2D GAME DEVELOPMENT (LABSHEET)

Topic 3.0 : Level Design




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 3 : Level Design (Part 1)

Next : Practical Task 2

A) Creating basic level design

1. Generating enemies

a. Open your previous project.

Create new folder inside Assets Folder and name it as “Prefab” by right click
inside Assets Folder - Create = Folder.

2 Seript
»
Creste
Show in Explorer
Open
Copy Path AltsCtrl+C
Sce
Scene Templas
Prefab M Project | o8 Game
Import New Asset.. fbd
Project | o8 Game. Import Package > | | 23 (;m..m [pssets
= Export Package... wdio Mixer QunM:ml:'
i Favorites | Assets
O, AllMaterial: O, All Prefabs
O, All Models Select Dependencies ;- |
S Refresh iR B Graphics
@ Assets Reimport 3 Prefab
B Graphics W Scenes Graphics Scenes enemySerpt spacesnioscrot
M Scenes Reimport All + W Packages
s Packages

e Animator Override Controller

Next, drag the ROCK into the Prefabs folder.

= Hierarchy
Fv (oAl

v € SampleScene

M Project | ©® Game

) Main Camera : + -
) BG_SPACE
gspacejhip v = Favorites Assets > Prefab
O, All Materials
O, All Models
O, All Prefabs
[ ¥
M Project | o8 Game v (@ Assets
2
1 Favorites Assets - Graph[cs
g:“: Materal] m Prefab L 1
O, Al Prefabs . Im Scenes rock
s
[ -.é:;mcs » Im Packages
[ Prefab
I Scenes Graphics Prefab
~ Im Packages

Then, delete the ROCK from the hierarchy by right click = delete.
Drag the SPAWN object from the GRAPHICS folder into the hierarchy tab.
|

= Hierarchy. 314 # scene | i
~||] e w2~

a Al
v & SampleScene*
Main Camera
) BG_SPACE
) space_ship.
 rock

B Project
+

v Favorites
O, All Material¢

O, All Models = Hierarchy = #
O, Al Prefabs - . A
S =0 @o R A _|st

m Graphics v € SampleScene*
i Prefab
I Scenes anemy ) Main Camera
» B Packages
0 BG_SPACE
@ - T
W9 rock >
1« space_ship

space_ship.1



DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 3 : Level Design (Part 1) Next : Practical Task 2

f.  Resize and reposition SPAWN object just above the background using RECT

TOOL. See the result below:
DI

V| @ w2 |v o H v

g. Now, let’s try to import script from outside into project.

h. Download script called “spawnScript” from CIDOS.

i. Import the script into your project (Refer Labsheet 1 to import object into
project folder).

j. Attach SPAWN (from hierarchy panel) to the spawnScript (Select SPAWN >
Inspector Panel 2 Add Component = type “spawnScript”.

Add Component
(= i B
Search
New script >
k. Click at ( +) button to add new Object to SPAWN.
¥ Objects 0
Listis Empty -y
r+ 1]
S Ui ¢ Add to the list
| Sprites-Default (Material) o:
Qhadar SQnritac/Nafanlt v Friir

|.  Drag ROCK from PREFAB folder into [None (Game Object)] inside inspector
panel. See below:

¥ # v Spawn Script (Script) o i
Script spawnScript
ame. 2 i

¥ Objects 1

& € K P19

= Element0 [None (Game Object)
Assets > Prefab + -
me 3

Sprites-Default (Material) o :
> Shader Sprites/Default v  Edit.
rock

Add Component ‘

2. Generating Weapon
a. Dragthe BULLET image from the GRAPHICS folder to the hierarchy tab.

‘= Hierarchy a8
+v (aA
v @ SampleScene*

) Main Camera

() BG_SPACE

0 space_ship

€0 spawn

\ = Hierarchy
P Gal Fv s
=
+v’°“"°' = v < SampleScene*
12 t;nvorﬂes Assets > Graphic; ) Main Camera
\ Al Materials
O Al odels " @ BG-SPAC_E
) Al Prefabs 7) space_ship
" @ Assets c (0 spawn
B Graphics 0 bullet

s Prefab U
I Scenes BG_SPACE bullet
» B Packages




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 3 : Level Design (Part 1)

Next : Practical Task 2

b. Add a “Box Collider 2D” component to it and make sure you have TICK at
“is Trigger” on Inspector panel.

v O v Box Collider 2D o
Edit Collider
Material :' " (Physics Material 2D) ®©
Is Trigger : v :
| |
Used By Effector B et
Used By Composite
Auto Tiling
Offset X 0 Y 0
Size X 0.15 Y 2.09
Edge Radius 0
» Info
Sprites-Default (Material) 0 :

c. Create new script on the BULLET (Select BULLET on Hierarchy - Add
Component = New Script = Type “bulletScript” = Create and Add). "o

Add Component

Add Component

al

Component

Layout

Mesh
Miscellaneous
Navigation
Physics 2D
Physics
Playables
Rendering
Scripts
Tilemap

< New script
Name

Create and Add

d. Find “bulletScript” inside Assets folder and double click to modify.

t | 0 refe 5

bulletScript : MonoBehaviour

Rigidbody2D rb;

rb = gameObject.AddComponent<Rigidbody2D>()
rb.bodyType = RigidbodyType2D.Kinematic;

Vector2(@.0f, 5.0f);

rb.velocity =

e. Make sure you add new line script at (line 7,line 12, line 14, line 15, line

22).



DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 3 : Level Design (Part 1) Next : Practical Task 2

f. Drag and drop the BULLET from the hierarchy tab to the Prefabs folder.

= Hierarchy 3

e Project | @® Game

v € SampleScene*

) Main Camera + -
(0 BG_SPACE
%j:ﬁff”“’ v = Favorites Assets > Prefab
@ bullet O, All Material¢
O, All Models
O, All Prefabs
:fmiec‘ EGams] v @ Assets /
v Favores s Ba Graphics
All Materialg
O: All Model: - Prefab
O Al Prevabss I Scenes bullet
v @ Assets » B Packages
M Graphics
I Prefab
I Scenes Graphics Prefab

» M Packages

g. Then delete the bullet from the scene.
3. Fire Bullet
a. To make the spaceship fire the bullets, we will need to make some changes
to our “spaceshipScript”.
b. Find “spaceshipScript” inside Assets folder. Open it and edit it as below:

s spaceshipScript : MonoBehaviour

GameObject bullet;

Start()

Update()

transform.Translate(Input.GetAxis("Horizontal™) * 5@f * Time.deltaTime, ©f, of);
transform.Translate(Input.GetAxis("Vertical™) * Vector3.up * 8f * Time.deltaTime);

if (Input.GetMouseButtonDown(®))
{

Instantiate(bullet, transform.position, Quaternion.identity);

c. Make sure you add new line script at (line 24 to line 27).
d. Play your scene.
4. Destroying Enemy
a. The spaceship, the enemies, and the bullets should collide with each other.
b. Add Box Collider 2D component to the SPACESHIP (Select on spaceship 2
Inspector Panel 2 Add Component = Type “Box Collider 2D”).

Add Component
(acoll )|
Search
W9 Box Collider =

Box Collider 2D

& Capsule Collider
0 capsule Collider 2D




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 3 : Level Design (Part 1) Next : Practical Task 2

c. Add BOX Collider 2D to the BULLET from Prefab folder (Select BULLET >
Inspector Panel 2 Add Component = Type “Box Collider 2D”).

-Pm]ecl o Game  E Console

Add Component
v = Favorites Assets > Prefab
O, All Materialg conl 3

O, All Models

O, All Prefabs. / Search
v @ Assets » ﬁ Box Collider

s Graphics Box Collider 2D

a Prefab

ll
M Scenes Capsule Collider
» B Packages 0 Ccapsule Collider 2D

d. Then, Add CIRCLE Collider 2D to the ROCK from Prefab folder (Select
BULLET - Inspector Panel 2 Add Component = Type “Circle Collider 2D”).

¥ 7 Favorites Assets > Prefab t [ circl] ]
O, All Materialg

O, All Models Search
O, All Prefabs
Clrcle Collider 2D
v (@ Assets
B Graphics New script >
Ba Prefab

s Scenes
» Bm Packaaes

e. Then select the ROCK prefab and check the "Is Trigger" optlon in the box
collider component.

v O v circle Collider 2D [
Edit Collider
Material ® Nege (Physics Material 2D) (]
Is Trigger "m
Faam
Used By Effector
Offset X 0 Y 0
Radius 0.665
» Info

f. Lastly, modify your “rockScript” and add these line to it.

(Collider2D other)
name = other.gameObject.name;

if (name == "bullet(Clone)™)
I
i
Destroy(gameObject) ;
Destroy(other.gameObject);
1
J

if (name == "space_ship")

E
1

Destroy(gameObject) ;

|

@ No issues found
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Now : Practical Task 2 Next : LABSHEET 3 — Game Level (Part 2)

DEPARTMENT OF INFORMATION TECHNOLOGY AND COMMUNICATION

Practical Task (s) No: 1/2/3/4

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

Instruction: Manipulating Unity Assets to build your first game scene Assets and Prop
1. Login to your CIDOS account and download “Practical_Task_2_Resources”
2. Open your previous project
3. Double Click to perform installation into your current project
4. Your will get 4 additional files: bigRock1, bigRock2, bigRock3 and wall_1

r + Favorites Asse(s > Graphics

-N ’n P

Q Al Models
O, All Prefabs

7 @@ Assets

B Graphics BG_SPACE bigRock2 bigRock3 enemy
I Prefab
B Scenes
+ Im Packages . g % q
| t
particles space. shh space_ship... a1

5. Drag wall_1 into hierarchy panel

6. Change value on “Order in Layer” to 4 (Select wall_1 on hierarchy = Inspector Panel = “Order in
Layer” = 4)

7. Reposition wall_1 to show result as below

lo|[e|w|e|~|mos |~

8. Select wall_1 and add BOX COLLIDER 2D into it (Add Component = Type Box Collider 2D)
9. Select on space_ship and add Rigidbody2D on it (Add Component = Type Rigidbody 2D)
10.Change the value to Gravity Scale to 0

v &  Rigidbody 2D @ 3 i

BodyTyee Dynamic -
Material None (Physics Mate ©

Simulated v
Use Auto Mass
Mass 1
Linear Drag 0
LSRN B0 m mw DDE
= Gravity Scale 0
SO T i 'Eﬂﬁr!(!
Sleeping Mode Start Awake
None

11. Do the same step to make the same wall at left side as shown below:




— ™
PoliTeSKMNi
Now : Practical Task 2

MALAYS|A Next : LABSHEET 3 — Game Level (Part 2)
MET:O EUALA LUMPUR

12. Then, select at the left wall, attach new script from inspector panel (Add Component = New
Script—> Type “loopWallScript” = Create and Add)

Add Compenent

< New script
Name

wa\lsarigﬂ

Create and Add

13. Find “loopScriptWall” at project panel and double click and edit your script just below:
loopWallScript.es & X | bulletScript.cs

2 Assembly-CSharp

System.Collections.Generic;
UnityEngine;

allScript : MonoBehaviour

scrollSpeed =
Vector2 StartPos;

newPos =

Mathf.Repeat(Time.time * scrollSpeed, 20);
transform.position = StartPos + Vector2.down * newPos;

14. Attach “loopWallScript” into right wall as well (Click on the right wall object at hierarchy tab >

drag loopWallScript at Assets folder = drop on to Add Component button at Inspector panel)
15. Done



DFG40323 2D Game Development
Practical Exercise 2

1. Rightclick at Level 1 and click ‘Save Scene As’, name as Level 2.

16 2-G20 - PE2 - Level 1 - PC, Mac & Linux Standalone - Unity 2020 3221} Personal <DX11>
File St Asets GemeObject Component Window Help

Drag new space background to folder Graphics & then drag to Hierarchy panel.

Delete the previous background by right click at it & delete.

Rearrange the new background using move tool (W) and rect tool (T).

Right click spawn at Hierarchy panel, and rename as spawn_rock.

Right click spawn at Hierarchy panel, and click Dupliate.

Rename the new spawn as spawn_enemyship.

Click spawn_enemyship at Hierarchy panel, by using move tool, move it above spawn_rock.
Your Hierarchy panel & Scene tab will be like this:

= Hierarchy a i # Scene
sl = Shaded v 20 @ w & v @0 Hy

©CoNOOA~LDN

. — o wl*“ S | e

i
- -

|

|

==
L&
|

E

.’;_

10. Go to folder Graphics, drag enemy ship 3 to Hierarchy panel. Then drag it back to folder
Prefab.

11. Click enemyship at folder Prefab - at the Inspector panel, click Add Component at the
bottom.

12. Type New Script > name as enemyshipScript = click ‘Create and Add’ button.



13. Open enemyshipScript, and copy the code from rockScript. make sure the gameobject name
is right:

enemyshipScript.cs ® X
[€#] Miscellaneous File:

2D.Kinematic;

Start()

Update()

rb.velocity =

onTriggerEnter2D(Coll

name = other.ga ject.name;

if (name == "bullet

14. The enemyship wil not rotate randomly, so put the comment on the code by using ‘//’ in front of
the line.



15. Click spawn_enemyship at Hierarchy panel and click enemyship enemyship prefab. Drag
nemyship refab and drop at Element O. A

Default
4

B ~ spawn Script (Script)

Add Component

L}
o

* Favorites

16. Set spawn time spawan_enemyship to 3 and spawn_rock to 0.5.
17. Your game tab will be like this:

o G
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Now : Practical Exercise 2 (Level Design Part 2) ALAYS
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DEPARTMENT OF INFORMATION TECHNOLOGY AND COMMUNICATION

Practical Exercise (s)No: 1/2/3/4 MARKS: /20

Name: Registration No.:

Code & Course: DFG40143 - 2D GAME DEVELOPMENT Class:

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game
developmenttools to maintain coherency in game. (P4, PLO3)

A) CREATE NEW LEVEL SCENE

Question:

Your company are working on action 2D game project. Your supervisor gives a task for you to develop new
level scene (Level 2) for your current game project. DUPLICATE your LEVEL 1 scene (Right Click on Scene 2>
Duplicate = Rename as “Level 2”), and modify your Level 1 scene to meet the Level 2 requirement shown
as below:

Level 1 Requirement Level 2 Requirement

- Rock coming more frequently

- New background

- New enemy coming (use new spaceship)
but infrequently

- Rock coming infrequently
- Player can shoot rock
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Now : Practical Exercise 2 (Level Design Part 2) MALAYSIA
METrO EUALA LUMPUR

Paste your Level 2 Scene which you develop below:




2D GAME DEVELOPMENT (LABSHEET)

Topic 4.0 : Game
Interactivity




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (Part 1) Next : Practical Task 3 : Interactivity (Part 2)

A) Creating Pop-up Panel
1. Importing new graphic assets.
a. Download Labsheet_4_Resources from CIDOS/ google classroom.
b. Extract Labsheet_4 Resources.zip.

exitB menuB nextB playB replayB

success try_again

c. Open your previous project (Practical Exercise 2).
d. Import the content into your project Asset.

Game = 2
& K e
Assets > Graphics
il

-NWﬁoﬂm@@@

BG_SPACE bigRock1 bigRock2 bigRock3 bullet digitalart-1634... enemy exitB menuB next8

@ =2 O Crdp e Gpm oo

particles playB replayB space_ship space_ship_1 spawn success try_again




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (Part 1) Next : Practical Task 3 : Interactivity (Part 2)

2. Preparing pop-up
a. Create new Canvas and name it as “Canvas Pop-up”; (Hierarchy = (+) 2 Ul
- Canvas = type “Canvas Pop-up”).

‘
+v o All Shad
Create Empty i

Create Empty Child
Create Empty Parent

2D Object >
3D Object >
‘ Effects >
Light >
Audio >
Video >
Text
Camera Text - TextMeshPro
_— Image
Raw Image
Button
M Project | @ Game J Button - TextMeshPro r
qrY Toggle
O, All Models Scrollbar
O, All Prefabs Dropdown
v @ Assets Dropdown - TextMeshPro c
: g:g:cs Input Field
B Scenes BOSPAC | ut Field - TextMeshPro

- e |
Panel
Scroll View

b. Next, create new emptyClip inside “Canvas Pop-up” (Select Canvas Pop-up
- (+)>Create Empty = type “Pop_up_try_again”).

File Edit Assets GameObject Component Window Help
I VSO E E EIER I EPivot | @3Global
= Hierarchy | 2 #

+ v ar All
Create Empty

Create Empty Child

Shi

2D Object >

3D Object > ]

Effects , ¥) Canvas Pop-up

ot ’ ) Pop_up_try_again
Audio >

Video >

ul >

Camera

Bu Project | % Game
Too




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (Part 1)

Next : Practical Task 3 : Interactivity (Part 2)

c. Then, create new Image inside “Pop_up_try again”;
(Select Pop_up_try_again = Right Click 2 Ul >Image > Name it as

“Black_Background”)

Paste As Child

RELEL T
Duplicate
Delete

Select Children
Set as Default Parent

Create Empty
Create Empty Parent
2D Object

3D Object

Effects

Light

Audio

Video

ul

Camera

Clear Parent

Move To View

Align With View
Align View to Selected
Toggle Active State

Properties...

o o

N A\

Text

Text - TextMeshPro
Image

Raw Image

Button

Button - TextMeshPro

Toggle
Slider
Scrollbar

d. Change the colour setting as below (Inspector Panel = Color > Change

value).

Color
' (S
m /s

E(’\.

LILL

RGB 0-25¢~
R || 0
G ] 0

.
A
Hexadecimal 000000

Vv Swatches
B/ Click to add new preset

LI&E

o



DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (Part 1) Next : Practical Task 3 : Interactivity (Part 2)

e. Resize the Image to cover all the canvas.

50‘53/ v W ¥ Gizmos | v | & All

S R
A

f. Next, insert new Image inside “black_background” (Select “black_

background” - Right Click 2 Ul = Image - Name is as “panel try again”).

& Canvas Pop-up
@ Pop_up_try_again
D black_background
D EventSystem c

ut
Copy

Paste As Child

Rename
Duplicate
Delete
8 Console @G g0t Children
Set as Default Parent

Create Empty

Create Empty Parent

2D Object

3D Object

Effects

Light

Audio & Canvas Pop-up

Video @ Pop_up_try_again

ul Text & black_background

Camera Text - TextMeshPro =
anel try again
Clear Parent Image Ea P Y g

Move To View Raw Image

Align With View Button

Align View to Selected Button - TextMeshPro
Toggle Active State Toggle

Properties...




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (Part 1) Next : Practical Task 3 : Interactivity (Part 2)

g. Change the image source for “panel try again” to “try_again” from Asset
folder (Drag “try_again” into “Source Image” ).

v [&] v Image
Source Image None (Sprite)

: Color
3“0 w9219 |  Material e Material)
Raycast Target 4

» Raycast Padding
‘ Maskable v
’ ‘ Default Ul erial (Material)
> Shad Ul/Default

/ Add Component

try_again Pop-up Try Again ~

h. Now, resize the image as below:

# Scene

Shaded v ||| e|w ¢ |v|Bo|I~ % | mt v | Gizmos | v | o Al

2 i
a |8 @ %m0

i. Next, disable “Pop_up_try_again” from Inspector Panel (Untick radio
button from Inspector Panel).

© Inspector g

Ea v Pop_up_try_again Static v

v

Tag Untagged v Layer Ul

Rect Transform

center Pos X PosY
0] 0]




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (Part 1) Next : Practical Task 3 : Interactivity (Part 2)

3. Creating interactivity
a. Open “spaceshipScript” to modify.
b. Declare new GameObject variable called “Pop_up_try_again”.

@ Unity 0 references

ss spaceshipScript : MonoBehaviour

GameObject bullet;
GameObject Pop_ up_try again;

C.

{

var name = other.gameObject.name;
Debug.Log(name);
if (name == "rock(Clone)")

{

Destroy(gémeObject);

Pop_up_try again.SetActive(true);
Time.timeScale=0;

d. Select “SpaceShip” at hierarchy panel = drag “Pop-up Try Again” inside =
into inspector Panel = Popup Try Again.

v @ Canvas Pop-up A —*
¥ & Pop-up Try Agal v |2l v Sprite Renderer o
v (@ Black Background Sprite [s]space_ship
Panel Try Again Color
(0 EventSystem Flip Xy
Draw Mode Simple

Mask Interaction None
ite Sort Point Center

MateNal Q Sprites-Default
Vv AdditioNal Settings
Sorting L\yyer Default
Order in Laf\er 4
Vv # v Spaceshij\Script (Script) o
Script spaceshipScript
Bullet W bullet
Pop_up_try_again 1Pop-up Try Again
v O v Box Collider 2D o
Edit Collider
Material None (Physics Material 2D)

e. Save your script and Play.
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Now : Practical Task 3 Next : LABSHEET 4 — Interactivity (Part 3)

DEPARTMENT OF INFORMATION TECHNOLOGY AND COMMUNICATION

Practical Task(s)No: 1/2/3/4

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

A) Navigatiion Button
1. Setting up Win Pop Up
a. Navigate to the Canvas Pop Up and create new Empty inside it ( Select Canvas
Pop up =2 Right Click > New Empty > Name it as “ Pop up Win”

©BG — .
- o
v () Pop-ug Cut v (7) Canvas Pop-up
» (P Blac Copy ¥ () Pop-up Try Again
() EventSys » () Black Background
7[Pop-up Win|
Paste As Child @ EventSystem
Rename
Duplicate
Delete
Select Children ‘
Set as Default Parent
Create Empty Parent
2D Object >

b. Next, insert new image inside “Pop-up Win” (Select “Pop-up Win” = Ul =

Image = Name it as “Black Background”
g
v () Canvas Pop-up

¥ () Pop-up Try Again
» () Black Background
v (P Pop-up Win
{p)[Black Background
7 EventSystem

c. Change the color setting as below (Inspector Panel = Color = Change value) :
| color B
. B

iy

i y | Color : Black
Of
F ‘ | A:182

= RGB0-255v
- E—
o T o
. —
N | (o

Hexadecimal 000000

ue
)9 ¥ Swatches
o &)

= W Click to add new preset



Now : Practical Task 3
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d. Resize the Image to cover all the canvas

50 8% |~

¥ |® ¥ | Gizmos |~

ar A

Next : LABSHEET 4 — Interactivity (Part 3)

e. Next, insert new Image inside “Black Background”, (Select “Black Background”

- Right Click 2 Ul = Image > Name is as “Panel Win”

£ Black Background

P EventSystem Cut
Copy

Paste As Child

Rename
Duplicate
Delete

it % Game

{eres Assets > Graphics Set as Default Parent

All Material
All Models
All Prefabs l Create Empty
Create Empty Parent
e 2D Object >
Sraphics
j >
>refab BG_SPACE BRlobiec
peenes Effects >
ckages
Light >
Audio >
Video >

o8

Camera

Text

Text - TextMeshPro ¥ (7) Canvas Pop-up

Y5 bopiop [y Kasin
mage ‘ > 8 i
Raw Image ¥ (7 Pop-up Win
v () Black Background
puton T —
Button - TextMeshPro () EventSystem
Toggle
Slider
Scrollbar
Dropdown

Dropdown - TextMeshF
Input Field

Input Field - TextMeshP
Canvas

Panel

Scroll View

Event System
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Now : Practical Task 3

f. Change the image source for “Panel Win” to “success” from Asset Folder ( Drag
“success” into Source Image” )

W

v @ Canvas Renderer

Cull Transparent Mesh v

v [& v Image

Source Image

Color
Material
Raycast Target
» Raycast Padding
Maskable
Image Type
a i Use Sprite Mesh
»| e & P8 Preserve Aspect
Y VN0V N AN D It Ul Material (Material)
1O | | Shader  Ul/Default
;‘ exitB menuB : nextB .
|Panel Win ~
= Steverciarean)
=
o = ) R
— v {score )
n success try_again wall1

g. Now, resize the image as below :

2. Creating Navigation Button .
a. Insert new Ul Button inside “Panel Win” (Select “Panel Win” = Ul = Button 2>
Name is as “Reply Button” )
v Pop-up Win
v () Black Background
v () Panel Win
» 7[Reply Button]
7 EventSystem
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. : Next : LABSHEET 4 — Interactivity (Part 3
Now : Practical Task 3 T ALAYS A y ( )

b. Change the image source for “Reply Button” to “ReplyB” from Asset Folder (
Drag “ReplyB” into Source Image” )

Source Image ElreplayB
Color
Material None (Material)
Raycast Target v

» Raycast Padding
Maskable v
Image Type Simple

Use Sprite Mesh
Preserve Aspect

v ® - Button

Interactable v
S ;| Transition Color Tint
AP Targetfraphic EReply Button (Imag:
Color
- o yfhlighted Color
P 82 ° ressed Color
> Selected Color
Disabled Color
o anemy oy -

Reply BllltD"" i

P

c. Resize and reposition your button as below :

replayB

MievelCleared!™

d. Navigate to Hierarchy Panel and select the button and duplicate it.(Select Replay
Button - Right Click = Duplicate)

T@ Black Background
v () Panel Win
) Reply Buttop
(0 EventSystem Cut

Copy

Paste As Child

Rename

Delete

Select Children

e. Rename the button as “Main Button”
v () Pop-up Win
v () Black Background
v () Panel Win
» () Reply Button
» 7[Main Button|
0 EventSystem
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Now : Practical Task 3 Next : LABSHEET 4 — Interactivity (Part 3)

f. Change the image source for “Main Button” to “Menu B” from Asset Folder (
Drag “Menu B” into Source Image” )

g. Resize and reposition your button as below :

Level/Cleared!

& &
- s S IS

Score:

h. Select “Pop Win” from hierarchy panel and disable (UNTICK ) it at Inspector
Panel

i | @ Ingpector | %X Project Settings

@@op-up Win

Tag Untagged

v/ Rect Transform

center

2

i. Save your project
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Now : Practical Task 3 Mrr;?o'efnliﬁ:l_smpun Next : LABSHEET 4 — Interactivity (Part 3)

Name: Registration Num.:
Code & Course: DFG40323 - 2D GAME DEVELOPMENT Programme/Class:
Practical Task (S) No: 1 / 2 /i/ 4 MARKS: /20

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

1. Insert same buttons for “Panel Try Again”, the buttons are
a. Menu Button
b. Reply Button

2. Paste your final output for “Panel Try Again” below:
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Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)

A) Duplicating Game Object across Scene
a. Open your previous project.
b. Open scene Level 2 and Select “Canvas Pop-Up”

) Canvas Pop-up

c. Right Click on “Canvas Pop-Up” = Copy

) Canvas Pop-up

Paste

Paste As Child

Rename
Duplicate
Delete

Select Children

Set as Default Parent

d. Next, Open Scene “Level 1” from Assets Folder

e. Then, navigate to Hierarchy panel = Right Click = Paste
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Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)

= Hierarchy a i
+ - ar A
v <& Level 1

) Main Camera

() space_ship

(0 spawn

£ wall_1

0 wall_1 (1)

@ BG_SPACE

Cut

Copy

Duplicate

f.  You will have same “Canvas Pop-Up” in Scene 1 Hierarchy Panel

v € Level 1*
) Main Camera
7 space_ship
) spawn
0 wall_1
£ wall_1 (1)
@ BG_SPACE

(& Canvas Pop-up

g. Save your project

2. Scripting Navigate Button
a. Create new Empty inside Hierarchy Panel ( Hierarchy Panel = Right Click 2>
Create Empty = Name it as “Button Controller”
i

- M

v & Level 1*
£ Main Camera
) space_ship
) spawn
9 wall_1
£ wall_1 (1)
@ BG_SPACE
» () Canvas Pop-up
£)[Button Controller|

b. Select “Button Controller” and add new Script on it ( Button Controller >
Inspector Panel = Add Component = New Script = Type “ButtonScript”
—>Create and Add )
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Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)
@ ~ | Button Controller B Eutton Controller
" Tag Untagged *  Layer Default @, = (T 9 i O

v M Transform ¥ /. Transform

Position X1320 11240 Position X 320 ¥ 240
Rotation X 0 Y0 Rotation X0 Y0
Scale X1 vl Scale X1 Y
Add Component Add Component
(o] )

L Component < New script

Layout s [ AdID

o N ‘ [ButtonScript

Miscellaneous >

Navigation >

Physics 2D >

Physics >

Playables >

Rendering >

Scripts >

Tilemap >

ul >

Video >

= Create and Add
T -

c. Double click on “ButtonScript” to edit script
© Inspector £ Project Settings

@ ~| Button Controller
v Tag Untagged ¥ Layer Default

v /). Transform

Position X 320 Y 240
Rotation X 0 Y0
Scale X1 il 1
v # +~ Button Script (Script)
Script m
——

Add Component

d. Add new “NAMESPACE” at top line of script

ButtonScriptcs* 4 X
Assembly-CSharp
= System.Collections;

System.Collections.Generic;
UnityEngine;
UnityEngine.SceneManagement;
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Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)

e. Create new “METHOD” called ReplayMethod inside script (after method
Update)

void ReplayMethod()

void ReplayMethod()

SceneManager.LoadScene(8);
Time.timeScale =

g. Next, navigate to REPLAY button inside Pop Up Try Again, (Hierarchy Panel
—> Canvas Pop Up = Pop up Try Again = Black Background > Panel Try

again—> Replay Button)
m B
v () Canvas Pop-up

v Pop-up Try Again
v Black Background
Panel Try Again
> Main Button
» (1) Replay Button
> Pop-up Win
) EventSystem
(7 Button Controller
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Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)

h. Then, navigate to Inspector Panel and click ( + ) button inside OnClick()
area

Automatic

Visualize

N
Add tothe list
Add Component

i. Drag Gameobject “Button Controller” into “NONE” area

Color Tint
ElReplay Button (Image)

Automatic

Visualize

Runtime Only ~
None (Object) ©®

j- Then, click on “Function” and select Replay() method

Runtime Only ¥ ' No Function
@Button Contr @'« No Function

GameObject >

Transform >

bool enabled ButtonScript
string name

bool runinEditMode

string tag
Visualize bool useGUILayout

BroadcastMessage (string)

| ~ NoFunction )~ Cancelinvoke (string)
q Cancellnvoke ()
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Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)

k. Final step, navigate to Build Setting, (File = Build Setting), and drag Level 2
Scene inside “Scene in build” area.

Build Settings
Scenes In Build

v Scenes/SampleScene
[ SeeneallievalE

-/

)
3 pc, Mac & Linux Standalone <+ I; P

i Android Torget]
: . Archite
iOS ios Serverl
s PS5 Soovl
Create’
E WebGL Develoj
Autocot
WOS tvOoS Deep Pi
Script 0
~ra PS4 Scripts|
Assets > Scenes
E Universal Windows Platform
= Compre
Q fg) Xbox One

Player Settings...

l. You can delete “SampleScene” which already inside that area. (Right Click
- Remove Selection)

Build Settings
Scenes In Build

™ Scenes/SampleScene
v Scenes/Level 2

Remove Selection

m. Play and test your “Replay Button”



DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (part 3) Next : LABSHEET 4 : Interactivity (part 4)
Name: Registration No.:

Code & Course: DFG40143 2D GAME DEVELOPMENT Programme/Class:

EXERCISE

1) Attach “Replay()” into Replay Button inside Level 1 scene

2) Make sure Replay button on Level 1 scene is function
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Now : LABSHEET 4 : Interactivity (part 4) Next : LABSHEET 5 : Game Scripting (part 1)

A) Combining 2 project into 1 master project
1. Exporting new package
a. Open your “Practical Exercise 1” project which is contain “Main Menu
scene”. Example below :

&)
vSPFICESHlP ~

° SHooter 7%,

b. Select at Asset Folder

"M Project | E Console
=+ Q
v o« Favorites Assets
O, All Materials
O, All Models

\
O, All Prefabs . .

[aw Assets

I Graphics Graphics Scenes

= Scenes

> Im Packages

c. Navigate to Asset = Export Package; select “ALL” and click Export; Save as
“Main_Menu” into any location in your pc

= Hierarchy a i I # Scene | ©® Game * Animator

Fv| Bwori ™ |,3 v
porting package
, =]

Items to Export

v v mGraphics
v wa=background-01.png
v #Ebg.png
v ===Cool Text - SPACESHIPSHOOTER 3936757079
v ﬁemt_button png
~logo.png
v \a‘menu button.png
v i_iplay_button.png
v kisetting_button.png
¥ v BmScenes
v € Main_Menu.unity
v € SampleScene.unity
v _wSampleSceneSettings.lighting

All None v Include dependencies

d. Close your current project
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Now : LABSHEET 4 : Interactivity (part 4) Next : LABSHEET 5 : Game Scripting (part 1)

2. Importing “Main_Menu” Package into new project
a. Open your previous project (Labsheet 4 : Interactivity (part 3))
b. Then, Navigate to ( Assets = Import Package = Select
“Main_Menu.package” )

Assets GameObject Component Window Help

Show in Explorer

0.64x

Copy Path Alt+Ctrl+C

Import New Asset...

Import Package Custom Package...

c. Click Import button to perform import

Import Unity Package nl

im Main_Menu
=

v m Graphics A B
w=background-01.png ]
-bg png
=“Cool Text - SPACESHIPSHOOTER 39387570795
. oex\t_bunun png H
»=10go.png 3
‘ iZ¥menu_button.png 3
Oplay_lmﬂon.png 1
.¥setting_button.png |
¥ ~ BmScenes A B
€} Main_Menu.unity A B
s SampleSceneSettings.lighting

‘{ All None Cancel Import
d. Navigate to Scene folder, make sure which one is your main menu scene,
and rename to “Main_Menu” ; Click “RELOAD” if pop-up appear.

v Scale

&)
Q/SPFICESHIP <

0.36x | Maximize On n Piay | Mute Audio

ssets > Scenes

Q)Q)

Level 1 Level 2
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Now : LABSHEET 4 : Interactivity (part 4) Next : LABSHEET 5 : Game Scripting (part 1)

3. Scripting Navigate Button
a. Still in Main_Menu Scene, Create new Empty in hierarchy panel and
rename as “Button Controller”

= Hierarchy = Hierarchy
+ - ar A + - ar A
v € Main_Menu*
Create Empty

£ Main Camera

» ) Canvas
7 EventSystem
[f)[Button Controller]

Create Empty Child

2D Obiject >
b. Attach “ButtonScript” script into gameobject “Button Controller”, ( Select

Button Controller > Add Component = Type “ButtonScript” )

Add Component

{2 butto| %]
Search
@ Button
New script >

c. Double Click at “ButtonScript” to open and edit the script

v #| v Button Script (Script e
Script ButtonScript

Add Component

d. Add new method or function below into your last line ( Line no 23)
U 25

ReplayMethod()

SceneManager.LoadScene(@);

GoTolLevel _1()

SceneManager.lLoadScene("Level 1");

e. Make sure “Main_Menu” is same name with your scene name inside Scene
Folder

Assets > Scenes

GoToLevel 1() > Q Q

ager.LoadScefe("Level 1"); Level 1 Level 2 Sa
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Now : LABSHEET 4 : Interactivity (part 4) Next : LABSHEET 5 : Game Scripting (part 1)

f. Select at the Play button at Hierarchy Panel and navigate to Inspector Panel

vipLAY
v € Main_Menu* ; v PLAY n
Untagged - ul

Color Tint
EIPLAY (Image)

Automatic

Visualize

g. Select at (+) and drag “Button Controller” into “NONE” Area

Color Tint
EIPLAY (Image)

Automatic

Visualize

Rg¥re ony ~ [No Function ]




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 4 : Interactivity (part 4) Next : LABSHEET 5 : Game Scripting (part 1)

h. Select “No Function” and choose “GoToLevel_1() method or function

J-

Runtime Only ¥ - No Function
@Button Con @+ No Function

GameObject
Transform
bool enabled ButtonScript
string name
bool runinEditMode Pt Gy e
string tag
bool useGUILayout
BroadcastMessage (string)
Cancellnvoke (string)

Cancellnvoke ()

Add “Main_Menu” and “Level 1” Scene inside Build in Scene from Build
Setting and Close setting.

Save and test your project.



2D GAME DEVELOPMENT (LABSHEET)

Topic 5.0 : Game
Scripting
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

A) Setting up Health bar
1. Importing health bar graphic
a. Open your previous project (Labsheet 4 Part 4)
b. Download and Import Labsheet 5 part 1 Resources from CIDOS into
Asset/Graphics

*P**********************DOWNLOAD SECTIQN**F k% kst kokokbokdok kb ok bdkokok

4 'S Labsheet 5 Part 1 Resources &2

c. Navigate to Asset = Graphics; make sure you have 3 graphics which are
coinicon, healthicon and healthbar_border as below :

2. Creating health bar inside Hierarchy Panel
a. Navigate to Hierarchy Panel, create new canvas, and name it as “Canvas Ul”

= Hierarchy @ i | @ Inspector | %2 Project
v o
Create Empty
Create Empty Child
2D Object >
3D Object >
Effects >
Light >
Audio >
Video > = Hierarchy | 2 i
@
Camera lTr:x:g—eTextMeshPro v Q Level. 1* :
e ff) Main Camera
s 1) space_ship =
Button - TextMeshPro () spawn -
Toggle @ wall_1 |
Slider o) wall_1 (1)
Scrollbar ) BG_SPACE
Dropdown » [7) Canvas Pop-up
Dropdown - TextMeshPro (1) Button Controller
Input Field £ Canvas Ul
Input Field - TextMeshPro @ EventSystem
Canvas
Panel -
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

b. Then, create new Image inside “Canvas Ul” ; (Select Canvas Ul = Right Click
- Ul = Image - Name as “Health bar border”

» () Canvas Pop-up Pixel Perfect
() Button Controller Sort Order 0
Target Display Display 1

Cut
(D Eve - Additional Shader Chan Nothing
opy

Text
Paste As Child Text - TextMeshPro 1
Rename
Duplicate Raw Image
Delete Button

Button - TextMeshPro

Toggle
Set as Default Parent Slider
Create Empty Scrollbar
Create Empty Parent Dropdown
2D Object > Dropdown - TextMeshPro
3D Object > Input Field é BC;v_gPA(:.‘ E
Effects > Input Field - TextMeshPro > @ Canvas Pop-up
Light < Canves 71 Button Controller
oo : Eane # v £ Canvas Ul
Vo : scrollView ff[Health bar Border]
ul Event System @ Ev entSystem
Camera
Properties...

c. Change image source for “Health bar Border” as healthbar_border, (Select
“Health bar border = Inspector Panel = Image Source = Image Source =
Drag Image into it )

BG_SPACE — o
> % Ca;vas Pop-up g @ LD pelone -
7 Button Controller 530.1456 139.2438 iR
¥ [[) Canvas Ul » Anchors
() Health bar Border Pivot X 0.5 Y 0.5
) EventSystem
Rotation X 0 X0 Z0
Scale X1 Y &l
» (@ canvas Renderer o
v [k v Image @ 3t
Source Image [Elhealthbar Berder @
Color Vs
Material None (iftertl) @
Raycast Target
» Raycast Padding
Maskable
Image Type Simple -
Use Mesh
erve Aspect v
Set Native Size
Default Ul Material (Material) L
Shader Ul/Default v | Edit...
coinbar_border
Add Component
’ » 1imy) G‘mml Health bar Border ~
healthbar_bord... healthicon loge h
— e o |

d. Select “Preserve Aspect” and resize your “Heathbar Border”

Source Image Iflhealthbar_
Color
Material None (Materi
Raycast Target v

» Raycast Padding
Maskable v

Image Type Singpl
Use Sprite Mesh

Preserve Aspect
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

e. Reposition your bar as below :

3. Adding health icon
a. Insert new Image inside “Healthbar border” , and rename as “heart” show
as below:

v ) Canvas Ul
v () Health bar Border

t|heart]

0 EventSystem

b. Change image source for “heart’ to “healthicon” from Assets/Graphic

folder
U ——
¥ () Canvas Ul » Anchors
¥ ) Health bar Border Pivot X 0.5 ¥ 0.5
) heart

Rotation X0 Y0
Scale X1 Y

() EventSystem

» (@ canvas Renderer

v [& v Image
Source Image Blhealthicon
Color
Material aterial)
Raycast Target

» Raycast Padding
Maskable
Image Ty,

Simple

reserve Aspect
Set Native Si

Default Ul Material (Material)

> Shader Ul/Default

Add Component

c. Duplicate and reposition “heart” and rename as “heart1”, “heart2” and
“heart3” shown as below :

v l_p Ldlivd> Ui
¥ () Health bar Border
) heart1
) heart2
0 heart3
F0) EventSystem

heart *

mj) (f_ﬁiug

logo

healthicon

d. Save your work
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

EXERCISE

1. Complete your project as output below for every scene you have :
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

A) Setting up Health bar
1. Importing health bar graphic
a. Open your previous project (Labsheet 4 Part 4)
b. Download and Import Labsheet 5 part 1 Resources from CIDOS into
Asset/Graphics

*P**********************DOWNLOAD SECTIQN**F k% kst kokokbokdok kb ok bdkokok

4 'S Labsheet 5 Part 1 Resources &2

c. Navigate to Asset = Graphics; make sure you have 3 graphics which are
coinicon, healthicon and healthbar_border as below :

2. Creating health bar inside Hierarchy Panel
a. Navigate to Hierarchy Panel, create new canvas, and name it as “Canvas Ul”

= Hierarchy @ i | @ Inspector | %2 Project
v o
Create Empty
Create Empty Child
2D Object >
3D Object >
Effects >
Light >
Audio >
Video > = Hierarchy | 2 i
@
Camera lTr:x:g—eTextMeshPro v Q Level. 1* :
e ff) Main Camera
s 1) space_ship =
Button - TextMeshPro () spawn -
Toggle @ wall_1 |
Slider o) wall_1 (1)
Scrollbar ) BG_SPACE
Dropdown » [7) Canvas Pop-up
Dropdown - TextMeshPro (1) Button Controller
Input Field £ Canvas Ul
Input Field - TextMeshPro @ EventSystem
Canvas
Panel -
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

b. Then, create new Image inside “Canvas Ul” ; (Select Canvas Ul = Right Click
- Ul = Image - Name as “Health bar border”

» () Canvas Pop-up Pixel Perfect
() Button Controller Sort Order 0
Target Display Display 1

Cut
(D Eve - Additional Shader Chan Nothing
opy

Text
Paste As Child Text - TextMeshPro 1
Rename
Duplicate Raw Image
Delete Button

Button - TextMeshPro

Toggle
Set as Default Parent Slider
Create Empty Scrollbar
Create Empty Parent Dropdown
2D Object > Dropdown - TextMeshPro
3D Object > Input Field é BC;v_gPA(:.‘ E
Effects > Input Field - TextMeshPro > @ Canvas Pop-up
Light < Canves 71 Button Controller
oo : Eane # v £ Canvas Ul
Vo : scrollView ff[Health bar Border]
ul Event System @ Ev entSystem
Camera
Properties...

c. Change image source for “Health bar Border” as healthbar_border, (Select
“Health bar border = Inspector Panel = Image Source = Image Source =
Drag Image into it )

BG_SPACE — o
> % Ca;vas Pop-up g @ LD pelone -
7 Button Controller 530.1456 139.2438 iR
¥ [[) Canvas Ul » Anchors
() Health bar Border Pivot X 0.5 Y 0.5
) EventSystem
Rotation X 0 X0 Z0
Scale X1 Y &l
» (@ canvas Renderer o
v [k v Image @ 3t
Source Image [Elhealthbar Berder @
Color Vs
Material None (iftertl) @
Raycast Target
» Raycast Padding
Maskable
Image Type Simple -
Use Mesh
erve Aspect v
Set Native Size
Default Ul Material (Material) L
Shader Ul/Default v | Edit...
coinbar_border
Add Component
’ » 1imy) G‘mml Health bar Border ~
healthbar_bord... healthicon loge h
— e o |

d. Select “Preserve Aspect” and resize your “Heathbar Border”

Source Image Iflhealthbar_
Color
Material None (Materi
Raycast Target v

» Raycast Padding
Maskable v

Image Type Singpl
Use Sprite Mesh

Preserve Aspect
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

e. Reposition your bar as below :

3. Adding health icon
a. Insert new Image inside “Healthbar border” , and rename as “heart” show
as below:

v ) Canvas Ul
v () Health bar Border

t|heart]

0 EventSystem

b. Change image source for “heart’ to “healthicon” from Assets/Graphic

folder
U ——
¥ () Canvas Ul » Anchors
¥ ) Health bar Border Pivot X 0.5 ¥ 0.5
) heart

Rotation X0 Y0
Scale X1 Y

() EventSystem

» (@ canvas Renderer

v [& v Image
Source Image Blhealthicon
Color
Material aterial)
Raycast Target

» Raycast Padding
Maskable
Image Ty,

Simple

reserve Aspect
Set Native Si

Default Ul Material (Material)

> Shader Ul/Default

Add Component

c. Duplicate and reposition “heart” and rename as “heart1”, “heart2” and
“heart3” shown as below :

v l_p Ldlivd> Ui
¥ () Health bar Border
) heart1
) heart2
0 heart3
F0) EventSystem

heart *

mj) (f_ﬁiug

logo

healthicon

d. Save your work
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Now : LABSHEET 5 : Game Scripting (part 1) Next : LABSHEET 5 : Game Scripting (part 2)

EXERCISE

1. Complete your project as output below for every scene you have :




Now : LABSHEET 5 : Game Scripting (part 3)

DFG40323 - 2D GAME DEVELOPMENT

Next : Practical Task 4: Game Scripting (part 4)

A) Preparing Script for Coin
1. Textfield for coin

Open your previous project and open your scene file (either level 1 or 2).

b. Add new Ul Text inside Canvas Ul, (Navigate Hierarchy - Canvas Ul

a.

—>CoinPanel = Right Click 2 Ul - Text

L) DULWIT S uTu et coalor
\/ ?éal_ni::;al;l'llel Material None (Material)

) CoinPanel P — 22
Cut g
Copy v
Paste Text
Paste As Child Text - Texgeshli’ro
Rename Image
Duplicate Raw Image
Delete Button

Button - TextMeshPro
Toggle
Set as Default Parent Slider
Create Empty Scrollbar
Create Empty Parent Dropdown
2D Object > Dropdown - TextMeshPro
3D Object > Input Field
| Effects > Input Field - TextMeshPro

Light > Canvas
Audio > Panel
Video > Scroll View
ul > Event System
Camera

Rename yout Text as “Coin_sum” as below:

L) D s st

v (P Canvas Ul
» (P LifePanel
v (P CoinPanel
@ Coin_sum

Navigate to Inspector Panel and resize your text size to fit with your
CoinPanel size ( use RECT TOOL at menu bar)

rie Eadit  Assets Lameupject L

W[+ O Ay
# Scene N

Chadad
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Now : LABSHEET 5 : Game Scripting (part 3) Next : Practical Task 4: Game Scripting (part 4)

e. Next Tick “BEST FIT” component in inspector panel

Alignment [—|§ = [—\ ==

Align By Geometry

Horizontal Overflow Wrap v
Vertical Overfl
Best Fit

Min Size

Max Size

f. Chahge “New Text” to “0” (ZERO)

» (@  Canvas Renderer o 3 i
v i v Text o
Text
0
Character
Font AaArial O]
Font Style Normal v
Font Size 14

2. Preparing Coin drop

a. Import New Labsheet 5 Part 3 Resources from CIDOS and import into your
project

Assets > Graphics
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Now : LABSHEET 5 : Game Scripting (part 3) Next : Practical Task 4: Game Scripting (part 4)

c. Select at the coin, add Rigidbody2D and Circle Collider2D component into

it
d. Change setting for Rigidbody2D as below:
v &%  Rigidbody 2D o 3
Body Type Dynamic v
Material None (Physics Material 2D) [©]
Simulated v

Use Auto Mass

Mass. 1

Linear Drag 0

Angular Drag )35\

Gravity Scale LD.OS N ]
Collision Detection + v
Sleeping Mode Start Awake v
Interpolate None v

» Constraints

e. And tick ISTRIGGER on Circle Collider 2D
v © ~ circle Collider 2D @ i

Edit Collider

Material (Physics Material 2D) @
Is Trigger
Used By Effector

Offset X 0 ¥ o0
Radius 0.75
¥ Info

Sprites-Default (Material) 9

> Shader Sprites/Default *  Edit.

f. Next, drag coin from hierarchy panel into PREFAB folder
’ (| 5 Button Controller
¥ ) Canvas Ul

» ) LifePanel
v (9) CoinPanel

Assets > Prefab

g. Then delete coin in Hierarchy panel
h. Next, duplicate “spawn_rock” from hierarchy panel and rename as
“spawn_coin"

v & Level 2* : mv ¥ - = M
) Main Camera Tag [
() space_ship vaT v Q Level 2% E

£ spawn_rock

gspawn_lenen Cut @ Main Camera

£ wall_1_right .

&0 wall_1_left Copy 0 space_ship

QB Paste spawn_rock
» § Canvas Pop Paste As Child | @ A

) EventSyster @lspawn_c0|n|
v % Camvasl|  Fename 0 spawn_enemy_ship

if i .
v Boamrane o (0 wall_1_right
inita Delete i
@ coin. [ 0 wall_1_left

A R
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Now : LABSHEET 5 : Game Scripting (part 3) Next : Practical Task 4: Game Scripting (part 4)

Navigate to hierarchy panel, change Object Elemen 0 to “coin” from Prefab
folder (drag and drop)

SRV

lﬂ ¥ ¢ < Spawn Script (Script) LI
at -
Scrip P

s 18

.....

ssets > Prefab ~
= 6 L] @
\q‘) !
1hb— -
e 03
™ fE
) o Sprites-Default (Material) H
> Shad [ fault E
= - e =

Add Component

3. Scripting Spaceship and Coin trigger

a.

Open “SpaceshipScript.cs”

b. Add this line into your script:

C.

if (name == "rock(Clone)")

{

life--;
Debug.Log("nilai semasa life :" + life);

if(life == 2)
{
heart3.SetActive( );
}
if( life == 1)
{
heart2.SetActive( DE
}
if (life == @)
{
Time.timeScale = ©;
Pop_up_try_again.SetActive(

}

if (name == "coin(Clone)")

{

T

Destroy(other.gameObject);
}

Save your script and test your project.
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Now: Practical Task 4 Mrrxo'efnli,q’qr_:l_smpun Next: LABSHEET 5 — Game Scripting (Part 5)

DEPARTMENT OF INFORMATION TECHNOLOGY AND COMMUNICATION

Practical Task(s)No: 1/2/3/4

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

A) Displaying Score

1. Modify script
a. Open your previous project (Labsheet 5 Part 3)
b. Open “spaceshipScript.cs” to edit
c. Add new line namespace at the top of script as below:

HVE

UWILLC

Assembly-CSharp
=i System.Collections;
System.Collections.Generic;
UnityEngine;
UnityEngine UI;I

d. Register new variable called “coin_sum” with ZERO as default value at the top of
class as below:

=] spaceshipScript : MonoBehaviour

GameObject bullet;
GameObject Pop_up_try again;

GameObject heartl, heart2, heart3;
life = 3;

coin_sum = ©;

e. Next, add new line below into your script to register new Text Object.

GameObject bullet;
GameObject Pop_up_try_again;

GameObject heartl, heart2, heart3;
life = 3;
coin_sum = ©;

Text Coin_txt;l
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MALAYS|A Next: LABSHEET 5 — Game Scripting (Part 5)
METrO EUALA LUMPUR

Now: Practical Task 4

f.
(Collider2D other)

var name = other.gameObject.name;
Debug.Log(name);

if (name == "rock(Clone)")
if (name == "coin(Clone)")

{

|

g. Last step, open your scene and navigate to hierarchy panel; drag “coin_text”

coin_sumt+;
Coin_txt.text = coin_sum.ToString();

Destroy(other.gameObject);

into Coin_txt at inspector panel as below:

¥ I v Box Collider 2D

& Level 1
() Main Camera Edit Collider
&) space_ship
p) spawn Material None (Physics Material 2D) (O]
o wall_1 Is Trigger
) wall 1 (1) Used By Effector
- % gg;i:}:gip-up Used By Composite
» (P Pop-up Try Again Auto Tiling
» Pop-up Win Offset X 0 Y|0
) Button Controller Size X 4.02 Y a1
M ?éal?#:;at;:lel Edge Radius 0
) heartl » Info
% :Z:g v & Rigidbody 2D e
¥ (7) CoinPanel Body Type Dynamic A
) coin_te Material None (Physics Material 2D) @
0 EPERTLET Simulated v
Use Auto Mass
Mass 1
Linear Drag 0
Angular Drag 0.05
Gravity Scale 0
Collision Detection Discrete v
Sleeping Mode Start Awake v
Interpolate None v
Constraints
» Nfo
v #N\/ Spaceship Script (Script) @ 3
Script spaceshipScript
Bullet W bullet (0]
Pop_up_tryNagain @ Pop-up Try Again 0]
Heart 1 @heart] (o]
Heart 2 fheart2 (0]
Heart 3 @ heart3 @
Coin_txt None (Text) (0]
Snrites-Nefault (Material) a

h. Save your project and test it.
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. : Next: LABSHEET 5 — Game Scripting (Part 5
Now: Practical Task 4 —MALAYS| A= pting (Part 5)

Name: Registration Num.:
Code & Course: DFG40323 - 2D GAME DEVELOPMENT Programme/Class:
Practical Task (S) No: 1 / 2 / 3 /A MARKS: /20

CLO 1: Display 2D assets, game interactivity, level design and scripting skills of game development
tools to maintain coherency in game. (P4, PLO3)

1. Make sure all scene (Level 1 and Leve 2) will show total coin collected by user.

2. Paste your final output below for BOTH scene:
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

A) Preparing Portal
1. Setting up Portal Animation
a. Open your previous project (Practical Task 4) > LEVEL 1 SCENE
b. Download Labsheet 5 Part 5 Resources and import into your project

Labsheet 5 Part | Resources &
Labsheet 5 Part 3 (coin.png) &

Labsheet 5 Part 5 Resources (Portal.png) &

FX_Portal_0004.png

Click at the graphic = Inspector Panel, and setting up SPRITE MODE from
SINGLE to MULTIPLE as below :

Use Crunch Campressic

a  Onl texture:

s with width/heioht being multinle of 4 can he

Next, Click SPRITE EDITOR and window will pop up as below:

Y

Revert  Apply

Texture Shape 2D v
Sprite Mode Single v
Packing Tag v~ Single
Pixels Per Unit Multiple s
Mesh Type v
Polygon
Extrude Edges = & |1
Pivot Center A
Genarate Phueire Sh o
d. Press APPLY
Sprite Mode Multiple -
Packing Tag
Pixels Per Unit 100
Mesh Type Tight bl
Extrude Edges -+
Generate Physics Sh v
Sprite Editor
» Advanced
Wrap Mode Clamp -
Filter Mode Bilinear -
Aniso Level @ 1
Default [=] W
Max Size 2048 bt
Resize Algerithm Mitchell =
Format Automatic =
Compression Normal Quality >

Sprte Editer
Sprte Editor = Slice = T Fevert

Apsly @ | &——3

%u;“
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

f. Then, click “Slice” = click Slice = Click APPLY

Sprite Editor*
Sprite Editor » |Slice » _ Trim Revert |Apply O &——@
Automatic

h. Close the window, next navigate to Graphic folder = select at the ARROW
button beside the portal graphic and make sure the graphic will produce as
below

Sprite_FX_Portal_... Sprite_FX_Porta... Sprite_FX_Porta... Sprite_FX_Porta... Sprite_FX_Porta...
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

i. Next, Create new 2D SPRITE at Hierarchy Panel (navigate to Hierarchy Panel
- 2D Object = Sprites = Square

cut

Copy

Duplicate

Delete

Create Empty

2D Object > Sprites > Square

3D Object > Physics > Circle

Effects > Tilemap > Capsule

Light > Sprite Shape > Isometric Diamond
Audio > Pixel Perfect Camera Hexagon Flat-Top
Video > Sprite Mask Hexagon Pointed-Top
ul > 9-Sliced

Camera

j-  Rename as “Portal”
() Button Controller
» () Canvas Ul
) spawn_coin

(p)|Portall

k. Navigate to Inspector Panel = Drag “Portal’s First Slice” into Sprite area as

below :
» tg vanvas ur -
) spawn_coin Sprite E1Square @
) Portal Golor ’
Flip X ¥
Draw Made Simple -
Mask Interaction None -
Sprite Sort Point Center
Material @ Sprites-Deigflit ®
¥ Additional Settings
Sorting Layer Default
Order in Layer o
Sprites-Default erial) a

shader Sprigggefault
R 5

/ Add Companent

Sprite_FX_Porta.. Sprite_FX_Porta . Sprite_FX_Porta_

I. Resize your “portal” as below
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

m. Next, navigate to Window = Animation, to display animation window

W i

W Poject B Console | © Animation N L
Preview ®) e 14 B b | - o A o . «

g Por

L

n. Next, Click at “porta

at hierarchy panel = Animation windows = Click

III

“CREATE”

|010 oS 020 (03 0:30 035 00 0

To begin animating Portal, create an Animator and an Animation C
Create

0. Save as “portal_anim” (save inside Animation folder)

n Create New Animation

& v « Labsheet > Labsheet5Part5 > Assets > Animation v
Organize ~ New folder
~
Labsheet Name ' Date modified
Labsheet 5 Part No items match your search.
PDF

> g Creative Cloud Fi
> @ OneDrive - Perso

> [ This PC 2

7—

File name: ‘ pcrtalfaniml —

Save as type: anim

p. Next it will end up like below

@ Animation

Preview @ 14 14 B | M M 0

portal_ani MEEAENS
Add Property

Dopeshest B




DFG40323 - 2D GAME DEVELOPMENT

Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

g. Next, drag 4 (FOUR) clip portal below into animation timeline as below
(Select All graphics and drag):

Preview @ 4|1 | b W laon -

© Animation

Preview | (@ w4 | |4 | B | Bl 0 0:00 0:05
portal_anim v & 0| [y
» [FPortal : Sprite L] 1900010
Add Property
e ... |
r. Preview your animation by click on the PLAY button below

| =

s Project  E Cons: © Animation

Preview | @ | | |4 | > [Pl | PM 2 0:00 (

portal_anim v & | O | 04

» [l Portal : Sprite &

Add Property

s. Reposition your “PORTAL” as below :

t. Add “BOX COLLIDER2D into the “PORTAL” and tick “ISTRIGGER” item on it

¥ [0 - Box Collider 2D e
Edit Collider

{<bo <[P [ &
T Material (Physics Material 2D) (o]
B Search Is Trigger

W Box Collider Used By Effector
E Box Collider 2D Used By Composite

¢ .

19, Articulation BEY (i Ul

4, Billboard Renderd ey - e

. Size X 0.27 X 077

diOngldbody Edge Radius 0

& Rigidbody 2D » Info
— @ skybox ) el Sprites-Default (Material) [
2f[EaNescript 4 > Shader Sprites/Default Edit.
a Ft
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

2. Scripting “Portal”
a. Open “spaceshipScript.cs” to modify script
b. Add new line below at the top of script :

spaceshipScript.cs* & X
& Assembly-CSharp - 4y

System.Collections;
System.Collections.Generic;

UnityEngine;
UnityEngine.UI;
UnityEngine.SceneManagement;

c. Next, add these “IF” condition inside OnTriggerEnter2D

name = other.gameObject.name;
Debug.Log(name);
if (name == "rock(Clone)")
if (name == "coin(Clone)")

{
Destroy(other.gameObject);

coin_sum++;
Coin_txt.text = coin_sum.ToString();

}

if (name == "portal")

d. Make sure, the name of your “portal” inside HIERARCHY same as name
inside SCRIPT

= Hierarchy a i
++ fa

v & Level 1
) Main Camera

() space_ship
) spawn
I

. n n g::wu )
if (name == pOf‘tal ) 1) BG_SPACE
» () Canvas Pop-up

() Button Controller

» 7} Canvas Ul
SceneManager . Loads (1) spawn_coin

e. Finally, add these line inside If condition below :

if (name == "portal™)

{

SceneManager.LoadScene("Level 2");

}
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

f.  Make sure, name of SCENE inside script, same as the scene name for your
LEVEL 2.

Assets > Scenes

o ® in_Men Sce .LoadScene{‘yvel 2");]

g. Save and test your project, make sure that your script is working. (Level 2
scene will load after spaceship colliding the portal)
h. Next, disablewygqrr “PORTAL” at hig(archy panel

Y SRS b
© Inspector  £* Project Settings 3
@portal Static v
Tag Untagged ¥ | Layer Default v
v 4. Transform (2 B
Position X0.03 Y 14.33 Z0

i. Register new Gameobject variable for “portal”
@ Unity Script | 0 references
=l spaceshipScript : MonoBehaviour

{

GameObject bullet;
GameObject Pop_up_try_again;
GameObject portal;

(Collider2D other)

name = other.gameObject.name;
Debug.Log(name);
if (name == "rock(Clone)")
if (name == "coin(Clone)")

{

Destroy(other.gameObject);

coin_sum++;
Coin_txt.text = coin_sum.ToString();
if(coin_sum > 20)
{
portal.SetActive( NE
}
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Now : LABSHEET 5 : Game Scripting (part 5) Next : Labsheet 5: Game Scripting (part 6)

k. Drag “portal” from hierarchy Panel into “spaceshipScript” at Inspector

Panel
-q- All

v € Level 1* H None (Physics Material 2D)

o
402 vl

Dynamic
None (Physics Material 2D)

Start Awake
None

'+ spaceshipScript
W bullet

@ Pop-up Try Again
None (Game Object)

|.  Save your project and run
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Now : LABSHEET 5 : Game Scripting (part 6)

A) Preparing Portal

1. Importing Audio File
a. Open your previous project (Practical Task 5) 2 LEVEL 1 SCENE

b. Download Labsheet 5 Part 6 Resources and extract it

xxxxxxxxxxxx

% Labsheet 5 Part 1 Resources

& Labsheet 5 Part 3 (coin.png)
s

Labsheet 5 Part 5 Resources (Portal.png)

E Labsheet 5 Part 6 Resources 6.

Create new folder insider ASSET folder called Audio (Right Click = Create

C.
- Folder = Rename as “Audio”
© Animation
Assets
Animation [ Audio | Graphics

AL AL
d. Import downloaded file inside Audio Folder inside Asset

M Project | E Console @ Animation

+-

v+ Favorites Assets > Audio

O, All Materials

O, All Models
coin hit

O, All Prefabs

v [@ Assets
Bm Animation
s Audio
I Graphics
I Prefab

2. Setting up Audio file
a. Create THREE (3) newEmpty and name it as “laser_sound”, “coin_sound”

and “hit_sound”

) laser_sound
) coin_sound
) hit_sound

b. Select at “laser_sound” and add new component called “Audio Source”

Add Component

{2 audio sourcel x)
Search

¢ Audio Source
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Now : LABSHEET 5 : Game Scripting (part 6)

c. Drag “laser.mp3” from Audio Folder insider “Audio Clip” area as below:

 Button Controlier
ul

d. Navigate to “Play On Awake” and UNTICK it.

v o v Audio Source @ 3+ @
AudioClip laser ®
Output None (Audio Mixer Group) ®
Mute
Bypass Effects

Bypass Listener Effects
Bypass Reverb Zones
Play On Awake

Loop

o T Y A"

e. Do the same step ( step b,c and d) to the “coin_sound” and “hit_sound”
3. Scripting audio file

a. Select “spaceShipScript.cs” and open it

b. Register new AudioSource Variable for “laser, coin and hit” as below :

Elpublic class spaceshipScript : MonoBehaviour

public GameObject bullet;

public GameObject Pop_up_try_again;
public GameObject portal;

public AudioSource laser, coin, hit;

c. Navigate to line below and add this script :

if (Input.GetMouseButtonDown(0))
{

Instantiate(bullet, transform.position, Quaternion.identity);

laser.Play();
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Now : LABSHEET 5 : Game Scripting (part 6)

if (name == "rock(Clone)")

{

Iiifz==8 /
hit.Play();

if(life == 2)

e. And last, this script to play COIN audio file :
if (name == "coin(Clone)")

Destroy(other.gameObject);
coin.Play();

coin_sum++;

Coin_txt.text = coin_sum.ToString();

if(coin_sum >= 5)

{
Save your Script.
g. Next, navigate to Hierarchy Panel, select SpaceShip and Drag
“laser_sound”, “coin_sound” and “hit_sound” into inspector Panel as

below :
5 ] & [ Account vlLayers vlLayout
= Hierarchy & i | @ Inspector | & Project Settings
+x (oA Collision Detection Discrete
v € Level 1* i Sleeping Mode Start Awake
) Main Camera |
. nterpolate None

() space_ship )

@ spawn » Constraints

£ wall_1 » Info

£ wall_1 (1) = = = -

() BG_SPACE Vv # v Spaceship Script (Script) o 3

b@Canvas Pop-up Script spaceshipScript
£ Button Controller Bullet @bullet ®
» (] Canvas Ul . : -

) spawn_coin Pop_up_try_again [ Pop-up Try Again ®

(0 portal / | @ portal (]

£ laser_sound Laser laser_sound (Audio Source) 0]

@ cF\ln_sound \ Coin coin_sound (Audio Source) 0]

£ hit_sound \.___.——-—-a
Hit hit_sound (Audio Source) 0]
Heart 1 fheartl ©
Heart fheart2 ©
Heart 3 fMheart3 (O]

Exercise:

A. Do the same step for Game Scene LEVEL 2
B. Download any MUSIC EFFECT and add it into your project, modify your project to play the
music at the start of the scene game
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